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SR1+: Quick Input Window
New Quick Input Window of SR1 and SR1+ integrates all former input windows in only one
dialogue window.

Quick Input Window provides a new option if you want to study the influence of one or more
parameters in a specific diagram: select required diagram at Display , then change input value and
click Calc button to actualize the diagram. Until now, you could do so with the result graphic
(Quick3) only.
If you configure help level 2, Quick Input opens automatic at program start.

The new Quick Input window in SR1+, due to large variety of input values, became relative large,
1280x900 pixel. If you want to display  it together with the graphic result window on one screen,
resolution should be 2560x1080 or higher. Minimum screen resolution required for SR1+ Quick
Input is 1280x1024, but in this case result graphic window is covered completely by the Quick
Input window.

You can skip Quick Input, well-known input windows  of earlier versions are available furthermore.



SR1+:  Compare FKR in Load-Extension Diagram
A customer asked why the residual clamping load FKR is not equal with the point of intersection in
the load-extension diagram, as shown in VDI2230-1 figure 2. In fact, FKR is the intersection point
for TBJ with bolt, but not for TTJ. And the reason is the supplement for plate resilience  Pzu
(equation 80,81,82). Thus, for TTJ the axial additional load FSA no longer calculated from the ratio
of P and S only, but distorted by Pzu. Deviation is huge, using example 1 of VDI 2230, FKR is
calculated 10.3kN, but the intersection poiunt in the diagram is only 2 kN. Deformation fPA is
calculated with P, not ( P+ Pzu).
To get residual clamp load for TTJ from the intersection point of the diagram, you either must
switch to TBJ, or at Edit->Calculation method Elasticity switch to deformation sleeve
(VDI2230-1986) . Then select Load-Extension diagram->working condition min. to display
residual clamp load FKR.

B1 of VDI 2230-1: FKR does not intersect in FKR         B1 as TBJ: FKR correct in intersection point

To get the required residual clamp load FKerf instead of FKR , display Load-Extension
diagram->working condition reqrd. . Same situation here: intersection point is correct for TBJ, but
not for TTJ.

It seems that equation (80) in VDI2230-1:2015 is wrong.
K = P / ( S + P) is the deformation ratio of plate load ratio. If " Pzu" used in numerator to

increase P, it must also be used in denominator to increase P.
According to VDI 2230-1:2015:  Pzu = (w-1)* M
According to VDI, w is the joint coefficient for the type of bolted joint . w is predefined for two
values only:  w=2 for TTJ and w=1 for TBJ

To say it less complicated and more straightforward than VDI, without w:
Pzu = M for TTJ
Pzu = 0  for TBJ



SR1+:  Calculation Method Pzu

In SR1 and SR1+, you can now configure at calculation method :
1. Pzu (80) VDI2230-1:2015: phiK calculated according to VDI2230-1:2015
2. P= P+ Pzu (TTJ): if TTJ, elasticity of nut thread " Pzu" added to P.
3. Pzu=0: elasticity of nut thread not considered (as for TBJ).
Use default method 1 if you think that calculation according to VDI2230-1:2015 is correct.
Configure method 2 if elasticity of nut thread should be considered  in P. Configure method 3 if
elasticity of nut thread should not be considered in P.

Example 1 of VDI 2230-1 with P= P+ Pzu                 Example 1 of VDI2230-1 with Pzu=0

If you configure method 2 or method 3, FKR is drawn correct in the intersection point of the load-
extension diagram. With method 2 ( P= P+ Pzu ), FKR=10.34kN (larger than 10.3 kN of VDI).
With method 3 ( Pzu=0), FKR=9.85kN (less than 10.3 kN of VDI).



ZAR4:  Quick View
ZAR4 Software for noncircular spur gears got new Quick Views with drawing, diagrams and tables
altogether on one screen.

For different screen size and resolutions different Quick View 1, 2, 3, 4 is provided. In Quick4
view, drawing, diagrams and tables are drawn together with an ISO 7200 drawing header. Quick
View drawings can be loaded into CAD.



ZAR5:  Pre-Dimension

In Pre-Dimension of ZAR5 you have the choice to input two of the tree values speed, torque and
power, and the third value is calculated.
And you can define a coefficient for safety and ratio face width / module. Safety less than 1
calculates smaller gears, and safety > 1 calculates larger planetary gears.

WN3: Shaft Stress
If you enter torque and additional bending moment in WN3, bending moment has no influence on
pressure and safety pperm/pmax. According to DIN 6892, WN3 calculates bending stress
Sigmabmax at the ground of the notch in the shaft from from bending moment.
WN3 now calculates reference stress of shear stress and bending stress
Sigmav =  (Sigmabmax² + 3 * taumax²), and shows an error message if yield point of shaft
material is less than reference stress.

FED2+: Quick3 with Loop position angle
Loop position rot. angle with tolerance has been added to Quick 3 View.



New Software ZAR7 for Plus Planetary Gears

A plus planetary gear set is an epicyclic gear set with planet wheel pairs instead of single planet
wheels. Stationary gear ratio is positive due to reversed sense of rotation. If planet carrier is
blocked, sun gear and ring gear rotate in same direction.

For calculation of load-bearing capacity, contact ratio, specific sliding,.., meshing gear pairs have to
be calculated separately. A plus planetary gear has 3 meshes: sun wheel with inner planet wheel,
inner planet wheel with outer planet wheel, outer planet wheel with ring wheel.
ZAR7 calculates all gear pairs and meshes in one sequence.

Animation simulates rotating gear wheels and planet on screen.

Roller bearings for the planet wheels can be selected from included database, ZAR7 calculates
bearing life expectation.

ZAR7 will be available soon.



New Software ZAR8 for Ravigneaux Planetary Gears

Ravigneaux gear sets are used in modern automatic and manual transmissions. Ravigneaux gear set
is composed of two planetary gear sets: one plus planetary gear set and one simple (minus)
planetary gear set. Plus and minus planetary set use a common ring gear and a common planet
carrier. And the outer planet wheel of the plus planetary set is the planet wheel of the minus
planetary gear set.

Ravigneaux gears have 4 ports (shafts, clutches):  small sun, large sun, carrier, and ring gear. To be
used as driving shaft, driven shaft, control shaft and idle shaft. If control shaft is blocked, 24 gears
could be shifted in theory. Practically, Ravigneaux gears use 4 forward gears and one rear gear, and
driven gear is always the ring gear.
For calculation of load-bearing capacity, contact ratio, specific sliding, .., meshing gear pairs have
to be calculated separately. A Ravigneaux planetary gear has 4 meshes: small sun wheel with inner
planet wheel, inner planet wheel with outer planet wheel, outer planet wheel with ring wheel, large
sun wheel with outer planet.
ZAR8 calculates all gear pairs and meshes in one sequence.

Roller bearings for the planet wheels can be selected from included database, ZAR8 calculates
bearing life expectation.

ZAR8 will be available soon.



New Software GR1 Gear Toolkit

GR1 calculates speed and transmission ratio of multistage gears composed of gear pairs, planetary
gear sets, plus planetary gear sets, Ravigneaux planetary gear sets or Simpson planetary gear sets.

GR1 will be available soon.



Making network versions running faster
Main reason if network versions run slowly is too much network traffic: too much data sent to and
requested from file server. At File->Settings->Directories you can configure important settings
and thus make network versions faster:

Most important setting: Temporary directory must be a local drive! Best choice is to configure a
RAM disk.

New Option Copy DBF -> TEMP
Another optimization is to copy the dbf database files into a local directory and configure this local
drive as database directory. But in this case an actualization problem remains: you must regularly
synchronize database files, or copy from network into local drive. Therefore a new option is
available now: if copy DBF -> TEMP is checked, dbf files are copied at program start from R/O
network directory into temporary directory, and used from temp directory during the session. Using
this new option, you do not have to copy dbf files nor change configurations: database directory
remains the write-protected network database directory.

If you, furthermore, copy the help files (hlp, plt, dem)  into a local directory and configure this local
directory (Directory help, images, demo) , you have only one network access at program start and
the network version runs as fast as a locally installed individual license.

Printer Portrait-Landscape
When changing printer at File->Printer , sometimes the printing orientation changed into the
standard setting of the new printer. This was changed now, printing orientation portrait or landscape
remains unchanged when selecting another printer.



HEXAGON  PRICELIST  2016-11-01
PRODUCT EUR
DI1 Version 1.2  O-Ring Seal Software 190,-
DXF-Manager Version 9.0 383,-
DXFPLOT V 3.2 123,-
FED1+ V29.1 Helical Compression Springs incl. spring database, animation, relax., 3D,.. 695,-
FED2+ V20.0 Helical Extension Springs incl. spring database, animation, relaxation, ... 675,-
FED3+ V18.7 Helical Torsion Springs incl. prod.drawing, animation, 3D, rectang.wire, ... 480,-
FED4 Version 7.2 Disk Springs 430,-
FED5 Version 15.2 Conical Compression Springs 741,-
FED6 Version 15.9 Nonlinear Cylindrical Compression Springs 634,-
FED7 Version 12.7 Nonlinear Compression Springs 660,-
FED8 Version 6.8 Torsion Bar 317,-
FED9 Version 6.0 Spiral Spring 394,-
FED10 Version 3.3  Leaf Spring (complex) 500,-
FED11 Version 3.3  Spring Lock and Bushing 210,-
FED12 Version 2.4  Elastomere Compression Spring 220,-
FED13 Version 3.9  Wave Spring Washers 185,-
FED14 Version 1.4  Helical Wave Spring 395,-
FED15 Version 1.3  Leaf Spring (simple) 180,-
FED16 Version 1.0  Constant Force Spring 225,-
GEO1+ V6.1 Cross Section Calculation incl. profile database 294.-
GEO2 V2.6 Rotation Bodies 194,-
GEO3 V3.3 Hertzian Pressure 205,-
GEO4 V4.1 Cam Software 265,-
HPGL-Manager Version 9.0 383,-
LG1 V6.4 Roll-Contact Bearings 296,-
LG2 V2.2 Hydrodynamic Plain Journal Bearings 460,-
SR1 V22.1 Bolted Joint Design 640,-
SR1+ V22.1 Bolted Joint Design incl. Flange calculation 750,-
TOL1 V11.8 Tolerance Analysis 506,-
TOL1CON V1.5 Conversion Program for TOL1 281,-
TOL2 Version 3.3 Tolerance Analysis 495,-
TOLPASS V4.1 Library for ISO tolerances 107,-
TR1 V4.0 Girder Calculation 757,-
WL1+ V19.8 Shaft Calculation incl. Roll-contact Bearings 945,-
WN1 Version 11.6 Cylindrical and Conical Press Fits 485,-
WN2 V 9.6 Involute Splines to DIN 5480 250,-
WN2+ V 9.6 Involute Splines to DIN 5480 and non-standard involute splines 380,-
WN3 V 5.4 Parallel Key Joints to DIN 6885, ANSI B17.1, DIN 6892 245,-
WN4 V 4.5 Involute Splines to ANSI B 92.1 276,-
WN5 V 4.5 Involute Splines to ISO 4156 and ANSI B 92.2 M 255,-
WN6 V 3.0 Polygon Profiles P3G to DIN 32711 180,-
WN7 V 3.0 Polygon Profiles P4C to DIN 32712 175,-
WN8 V 2.2 Serration to DIN 5481 195,-
WN9 V 2.2 Spline Shafts to DIN ISO 14 170,-
WN10 V 4.0 Involute Splines to DIN 5482 260,-
WN11 V 1.3 Woodruff Key Joints 240,-
WNXE V 2.0 Involute Splines - dimensions, graphic, measure 375,-
WNXK V 2.0 Serration Splines - dimensions, graphic, measure 230,-
WST1 V 10.0 Material Database 235,-
ZAR1+ V 25.3 Spur and Helical Gears 1115,-
ZAR2 V7.7 Spiral Bevel Gears to Klingelnberg 792,-
ZAR3 V8.9 Worm Gears 404,-
ZAR4 V5.0 Non-circular Spur Gears 1610,-
ZAR5 V11.0 Planetary Gearings 1355,-
ZAR6 V3.7 Straight/Helical/Spiral Bevel Gears 585,-
ZARXP V2.1 Involute Profiles - dimensions, graphic, measure 275,-
ZAR1W V1.7 Gear Wheel Dimensions, tolerances, measure 450,-
ZM1.V2.4 Chain Gear Design 326,-



PACKAGES EUR
HEXAGON Mechanical Engineering Package (TOL1, ZAR1+, ZAR2, ZAR3+, ZAR5, ZAR6, WL1+, WN1,
WN2+, WN3, WST1, SR1+, FED1+, FED2+, FED3+, FED4, ZARXP, TOLPASS, LG1, DXFPLOT, GEO1+,
TOL2, TOL1CON, GEO2, GEO3, ZM1, WN6, WN7, LG2, FED12, FED13, WN8, WN9, WN11, DI1,
FED15, WNXE)

8,500.-

HEXAGON Mechanical Engineering Base Package (ZAR1+, ZAR3+, ZAR5, ZAR6, WL1+, WN1, WST1,
SR1+, FED1,+, FED2+, FED3+) 4.900,-

HEXAGON Spur Gear Bundle (ZAR1+ and ZAR5) 1,585.-
  HEXAGON Involute Spline Package (WN2+, WN4, WN5, WN10, WNXE)     1,200.-
HEXAGON Graphic Package (DXF-Manager, HPGL-Manager, DXFPLOT) 741.-
HEXAGON Helical Spring Package (FED1+, FED2+, FED3+, FED5, FED6, FED7) 2,550.-

HEXAGON Tolerance Package (TOL1, TOL1CON, TOL2, TOLPASS) 945.-
HEXAGON Complete Package (All Programs of Engineering Package, Graphics Package, Tolerance

Package, Helical Spring Package, TR1, FED8, FED9, FED10, ZAR4, GEO4, WN4, WN5,
FED11,WN10, ZAR1W, FED14, WNXK, FED16)

11,500.-

Quantity Discount for Individual Licenses
Licenses 2 3 4 5 6 7 8 9 >9
Discount % 25% 27.5% 30% 32.5% 35% 37.5% 40% 42.5% 45%

Network Floating License
Licenses 1 2 3 4 5 6 7..8 9..11 >11
Discount/Add.cost -50% -20% 0% 10% 15% 20% 25% 30% 35%
(Negative Discount means additional cost)

Language Version:
- German and English : all Programs
- French: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED10, FED14, TOL1, TOL2.
- Italiano: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9.
- Swedish: FED1+, FED2+, FED3+, FED5, FED6, FED7.
- Portugues: FED1+
- Spanish: FED1+, FED2+, FED3+

Updates:
Update prices EUR
Software Update (software + pdf manual) 40,-
Software Update (software 64-bit Win + pdf manual) 50,-

Update Mechanical Engineering Package: 800 EUR, Update Complete Package: 1000 EUR

Maintenance contract for free updates: annual fee: 150 EUR + 40 EUR per program

Upgrades
For upgrades to network licenses or plus versions or software bundles, upgraded licenses are credited 75%.

Hexagon Software Network Licenses
Floating License in the time-sharing manner by integrated license manager
Individual licenses may not be installed in a network!

Conditions for delivery and payment
General packaging and postage costs are EUR 60, (EUR 25 inside Europe)
Delivery by Email (program packed, manual as pdf files): EUR 0.
Conditions of payment: bank transfer in advance with 2% discount, or by credit card (Master, Visa) net.

Key Code
After installation, software has to be released by key code. Key codes will be sent after receipt of payment.

HEXAGON Industriesoftware GmbH
Stiegelstrasse 8      D-73230 Kirchheim          Tel.+49 702159578     Fax +49 7021 59986
Kieler Strasse 1A      D-10115 Berlin                   Mühlstr. 13      D-73272 Neidlingen
Mobile: +49 163 7342509       E-Mail:  info@hexagon.de           Web: http://www.hexagon.de

http://www.hexagon.de

